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Reggio Emilia - Italy
This is a legal agreement between RCF Spa Reggio Emilia - ITALY and you (either person 
or corporation) regarding the use of this SOFTWARE. Please read carefully the terms of this 
License Agreement before installing or using this SOFTWARE. If installing, copying or starting 
the use of this SOFTWARE, you hereby agree to the terms of this Licence Agreement.

1. GRANT OF LICENCE
RCF Spa grants you the following non-exclusive rights to use the SOFTWARE in accordance 
with the terms of this Licence Agreement.
a. You may use the SOFTWARE only on a specific single computer at one time. The 

SOFTWARE use includes the SOFTWARE loading into temporary memory (i.e. RAM) 
or installing the SOFTWARE into a storage media (i.e. hard disk) of the computer, on 
which you will use the SOFTWARE.

b. You may make one copy of the SOFTWARE for backup purpose only (CD, DVD or any 
other media), but other copies are prohibited.

c. Multiple-Shift Usage and Network Usage: you may use the software with whatever 
available PC. Yet, if you have to change PC, you shall delete the software from the 
mass storage of the used PC and ask the manufacturer for a new licence code 
(free of charge), because the old license code will not be valid any more. It is not 
allowed to store or use the SOFTWARE on more than one PC. The software use in a 
network or another computer system with several workstations (where the program 
can be simultaneously used by several computers) is not allowed. If you need to use 
the software in a network (or another system with several workstations), it will be 
necessary to purchase several licence codes from RCF Spa.

2. COPYRIGHT
The SOFTWARE and its copyrights are property of RCF Spa and are protected by all 
international copyright laws and treaties. (therefore, you shall treat the SOFTWARE like any 
other copyrighted material (i.e., CD, DVD, book).
All rights not mentioned in this manual are reserved by RCF Spa.
Copyright information, the serial number and other software identification features must 
not be removed, changed or hidden.

3. OTHER RESTRICTIONS
d. You are not allowed to modify, change, try to decompile the SOFTWARE, the copyright 

information and logos.
e. You shall not loan, rent, lease, sublicense or transfer the SOFTWARE, whole or a part 

to others. It is allowed to transfer it (and the respective printed materials) to others 
permanently if you retain no copies of the SOFTWARE and the new owner agrees 
to the terms of this Licence Agreement. If the SOFTWARE has been updated, any 
SOFTWARE transfer shall include the most recent update and all prior versions. The 
new owner shall get a new licence code (free of charge) from the manufacturer to 
ensure the full software operation.

f. You must not supply the SOFTWARE to others, if these may breach the contract terms 
to create illegal copies.

g. If this SOFTWARE contains multiple types of media (such as floppy disks and CD-ROM) 
and these media contain the same software, you may use only the one form of media 
that is appropriate for your computer. You shall not use the remaining form(s) of media 
on another computer.

4. NO WARRANTY
RCF Spa does not provide any warranty (either expressed or implied) to any software, 
including (for instance) merchantability or suitability for a particular purpose.

5. NO LIABILITY
In no event shall RCF Spa be liable to end-users for any damage whatsoever, including but 
not limited to financial damages for loss of business profits or business information due to 
the software use or inability to use this product.

LICENCE 
AGREEMENT

RCF FORUM SOFTWARE 
LICENCE AGREEMENT
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The foregoing provision is effective even if RCF Spa has been advised of the possibility 
of such damages. Even if the SOFTWARE has any material, verifiable and reproducible 
program errors, RCF Spa shall have no obligation to modify such errors.

6. PC SYSTEM REQUIREMENTS
Due to differences among computers, it is not possible to determine the general system 
requirements for the optimum operation. In this manual you will find the recommended 
system requirements that have been evaluated after several tests with various PCs. Even 
if your PC fulfils the system requirements, problems might occur with this RCFFORUM 
software, due to special PC hardware or software configurations (it is not possible to 
guarantee a 100 percent compatibility with the RCFFORUM software).

7. TERMINATION OF THE LICENCE
RCF Spa reserves the right to revoke the licence if you fail to comply with any of the terms 
of this License Agreement. If the license is revoked, you shall immediately stop using this 
SOFTWARE.

8. GENERAL
h. Any provision of this Agreement which is prohibited or unenforceable in any 

jurisdiction shall be ineffective to the extent of such prohibition or unenforceability 
without affecting, impairing or invalidating the remaining provisions hereof.

i. This License Agreement shall be governed by and construed in accordance with the 
laws of ITALY (without reference to the principles of conflicts of laws).
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RCF S.p.A. would like to thank you for purchasing this product, which has been 
designed to guarantee reliability and high performance.

Insert the CD containing the installation software into the appropriate player. Make sure 
the computer on which the software will be used has the minimum requirements necessary 
(Windows XP® operating system). Explore the contents of the CD using the normal 
Windows commands, then run the “setup... .exe” file (the three dots indicate a progressive 
number of the used release).
The following dialogue window will open:

Select the proper language and press “OK” to confirm.

Then the following window opens:

Press “next” to confirm.

INSTALLATION
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You need to accept the licence terms in order to proceed.

At this point, proceed with the installation by choosing the directory in which the software 
will be installed.

The following window appears during the installation procedure to indicate its state.
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As soon as the installation is completed, click on “Finish”.

One icon is created on the desktop and there is a new folder in ../
Documents/Forum6000 and in the “Start” bar.

Run the Rcf Forum programme by clicking either the icon on the desktop or the links in the 
Start bar or from the Rcf Forum folder. 
The main management window of the programme opens:

USING THE PROGRAMME
CONNECTING THE 
CONTROL UNIT
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To connect the computer to the control unit, open the “Options” menu and select “Com 
port setup” to set the proper communication port,

select the “com” port number and then confirm by clicking on OK.

Again, in the “Options” menu, select “Connect central unit”:
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To create the synoptic panel for the conference room, arrange the consoles, assign general 
information related to delegates and insert an image, open the “SYNOPTIC” window and 
select “Blocked Consoles”.
To insert a background picture in the frame of the synoptic panel, open the “Synoptic” 
menu, “Load Picture”, select and open the desired file.
To move the icons of the consoles within the frame, select the icon and drag it, keeping the 
mouse left button pressed. To rotate it, press the mouse middle button, keeping the cursor 
on the icon to be rotated.

Use the mouse right button to activate and deactivate the console microphone: the ring on 
the microphone gets lit and, at the same time, the icon turns red.

CREATING 
THE LIGHTED 
DISPLAY BOARD
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A name can be associated by typing it into the “Name” and “Surname” lines.
Double click on a console icon to open its respective window:

Select the “MODE” window to enter the respective window and edit all parameters:

In the first frame “Free discussion - Active Mic”, you can select the max. number of 
delegate open microphones (activated consoles).

ALL DELEGATE OFF: all delegate consoles are forced off.
ALL CONSOLE OFF: all consoles (except interpreters’) are forced off.
FREE DISCUSSION: no limitation (free discussion).
MAXMICDEL1 + O/RIDE: 1 delegate open microphone at a time only and overridden by 
the next delegate.
FROM 1 TO 6: the max. number of delegate open microphones (n) is limited from 1 to 6.

The second frame “Automatic - Reservation” is used to set the delegate booking.

OFF: the delegate booking function is off.
NEXT: only 1 delegate can book after the max. number of open
microphones has already been reached. When a delegate turns its microphone off, the 
booked microphone will automatically turn on.
NEXT + N: Only 1 + n delegates (n = 1 to 9) can book after the max. number of open 
microphones has already been reached.

CONFERENCE 
MODE SETTING

THE OPTIONS OF THE FIRST 
FRAME ARE:

THE OPTIONS OF THE SECOND 
FRAME ARE:
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When a delegate turns its microphone off, the next microphone
(the first of the queue) will automatically turn on.

From the third frame “Options” you can select the INTERPRETATION, A & B INPUT 
MODE, VOX / CMD INPUT A, VOX / CMD INPUT B, CHIME ON CHAIRM, CONSOLE OUT 
JACK and MIC AUTO OFF options.

OFF: interpreter consoles are disabled.
SIMULTANEOUS: (simultaneous translation) when an interpreter console turns on (note: 
the other interpreter console automatically turns off), the translated language will be sent 
to the console jack outputs (console internal loudspeakers are off). The mixed signal of 
all consoles, IN A, IN B, IN PLAY (and the chime) will be sent to the other 2 system audio 
outputs (MAIN OUT and the audio output for teleconference).
SEQUENTIAL: (sequential translation) when an interpreter console turns on (note: the 
other interpreter console automatically turns off), the translated language will be sent 
to all the 3 system audio outputs (console lines, MAIN OUT and the audio output for 
teleconference). When the interpreter console turns off, the mixed signal of all consoles, IN 
A, IN B, IN PLAY (and the chime) will be sent to all the 3 system audio outputs.
 
CMD ACT, VOX ACT: IN A can be opened by either an external command (command = 
activation) or if the signal is automatically detected (VOX).
CMD ACT, VOX OFF: IN A can be opened by an external command only (command = 
activation). VOX function is off.
CMD MUTE, VOX ACT: IN A is opened if there is no external command (command = 
mute) and the signal is automatically detected (VOX).
CMD MUTE, VOX OFF: IN A is opened if there is no external command (command = 
mute). VOX function is off.

This setting is like the previous of INPUT A (“VOX / CMD INPUT A”), but regarding the 
INPUT B.
 
A MIX B MIX SYS: IN A, IN B and the console signal are mixed.
(A LOCK B) MX SYS: IN A and IN B are interlocked each other (first come – first served basis).
IN A / IN B and console signals are mixed.
(A PRIO B) MX SYS: IN A has higher priority than IN B.
IN A / IN B and console signals are mixed. 
(A MX B) PRIO SYS: IN A and IN B are mixed. IN A / IN B signal has higher priority than 
consoles.
SYS PRIO (A MX B): IN A and IN B are mixed. The console signal has higher priority than 
IN A / IN B.
A PRIO (B MX SYS): IN B and console signals are mixed. IN A has higher priority than IN 
B / consoles.

DISABLED: no signal available on console jack outputs (internal loudspeakers are on).
RECORDING: console jack outputs provide an optimised signal for
recording. Console internal loudspeakers keep working when jack outputs are used.
HEADPHONES: the signal for internal loudspeakers is also available on console jack 
outputs (for headphones). When headphones are used, the internal loudspeaker is off.

KEY ON: the chime is sent when a chairman activates the PRIORITY.
KEY OFF: the chime is NOT sent when a chairman activates the priority.

KEY ON: after 30 seconds of silent (no signal detected by the microphone capsule), the 
microphone automatically turns off.
KEY OFF: MIC AUTO-OFF function is off.

In the fourth frame “ANTILARSEN” you can set the anti-feedback options:

BYPASS: the anti-feedback processor is disabled.
SOFT: the anti-feedback processor intervention is moderate.
HARD: the anti-feedback processor intervention is significant.

“INTERPRETATION”

“VOX/CMD INPUT A”

“VOX/CMD INPUT B”

“A/B INPUT MODE”

“CONSOLE OUT JACK”

“CHIME ON CHAIRMAN”

“MIC AUTO-OFF”
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Select the “AUDIO” window to manage the volume level settings:

MASTER: MAIN OUT volume.
CONSOLE SPEAKER: console internal loudspeaker volume.
CONSOLE MIC: chairman / delegate console volume.
INTERPRETER MIC: interpreter console volume. 
AUX PLAY: PLAY input volume.
TELECONFERENCE: TELECONF. input volume.
MONITOR: master unit internal loudspeaker.
INPUT A: MIC / LINE INPUT A volume.
INPUT B: MIC / LINE INPUT B volume.

AUDIO SETTINGS
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To see the image of video cameras, you have to select the second monitor in the dedicated 
menu (Video/Show):

To use the video camera management SW, select “Plugin / Dome”. 
The dome setting window opens:

You have to set the number of the communication port used by the PC, in order to move 
the video cameras and switch the video matrix.
At the point 1 , select the number of the communication port between the PC and video 
cameras.

At the point 2 , select the number of the communication port between the PC and the 
video matrix. Once these parameters have been set, you have to enable the communication 
ports by clicking on the buttons “Camera”, “Mixer” and “Enabled” (point 7 ); these get 
lit to confirm the request for connection.

MANAGING 
THE VIDEO CAMERAS

P

{

}

1 7

8

9

2

3

4
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In the synoptic panel, select the microphone console that has to be aimed by a video 
camera. Select the number of the video camera to be used to frame the microphone console 
(point 4). Select either “1 Microphone” or “Room” (point 8 ), according to whether the 
frame to be saved is a microphone console or a generic image of the room.
Move the video camera by using the joystick simulator (point 5 ).
Press and hold the mouse left button inside the circle and move up, down, left or right; you 
can move the selected video camera.
This function makes it possible to move the camera rapidly. For a fine adjustment, use the 
arrows on the right of the circle.
Use the “Wide” and “Tele” keys to adjust the zoom (point {).
The focus and the iris of the video camera are automatic. If you want to make a manual 
adjustment, use the “Far” and “Near” keys for the focus and “Open” and “Close” for the 
iris (point {).
Once you have found the correct aim, press “Save” to save it.
Select the type of transition to use in the passage from one image to the next (point 3 ); 
there are four transition options:
no = no transition (you see the movement of the video camera)
black = the frame goes to black, the camera moves, and the image reopens from black
room = transitions from an image of the room
synoptic = transitions from the image of the synoptic panel

If the button in the left-hand corner (point 6 ) gets lit when you select a microphone 
console, this means that a camera aim has already been saved for that particular microphone 
console. To delete a camera aim, select the microphone console from the lighted display 
board and press “Delete” (point P).
To delete all the aims, press “Clear All” (point 9 ): a window appears to confirm.
To access the video camera setting menu, press “Menu” (point }). 
The video camera configuration menu opens (above the video image). Use the arrows on 
the right of the circle to move within the menu.
Move upwards or downwards to access the desired menu item and use the right arrow to 
enter the submenu.
When the microphone is switched on, the video camera automatically aims according to 
the presetting. If two or more microphones are switched on, the image of the room will be 
displayed. When only one microphone is switched on, the video camera returns to aim at 
the active microphone console.
The passage between one frame and the next always takes place with the type of transition 
set (point 3 ).

AIMING THE VIDEO CAMERA 
TO A MICROPHONE CONSOLE

When recording, the audio signal should be taken from the DMU 6100 main unit output 
and connected to the PC sound card input.
After connecting the main unit, open the “Recorder” section in “Window” menu:

Click on the “Audio Path” button (in the “Options” menu) to see the default path where 
audio recordings will be saved and to change it.
Click on the “Audio Format” button (in the “Options” menu) to choose the audio 
compression format for recordings.

To start recording, click on the  button. The meter on the right turns green following 
the sound input level and then it is possible to minimize the “Rcf ForumAudio” window 
and start the conference.
As soon as the conference ends, restore the “Rcf ForumAudio” window and press  to 
stop recording.

AUDIO RECORDING 
MANAGEMENT
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Click on the “On Hold” option in the “Window” menu to see the “Reservation List”.
The “RESERVATION LIST” shows the name list of the delegates who are booked to speak.
At the moment of booking, the keys change colour (from grey to blue) to confirm the 
booking.

 The first key activates the delegate’s microphone: the conference manager can 
activate or deactivate any microphone present on the list at any moment, without having 
to respect the booking order.
The second key cancels the delegate from the booking list.

Click on the “Show public view” option in the “Window” menu to see the “Public view”.

In the “File” menu, click on “Save” to save the synoptic panel and both MODE and AUDIO 
settings.
To load a stored configuration, after connecting to the PC to the main unit and turning the 
system on, click on “Open” in the “File” menu and load the necessary file.

In the synoptic panel, right-click on the chosen icon to enable / disable the respective 
microphone. In this way, it is possible to activate even more microphones than those 
already set in the system.
If a microphone included in the booking list is manually activated, this will be turned on 
without deleting it from the booking list.

RESERVATION LIST

PUBLIC VIEW
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Reggio Emilia - Italy
Il presente è un contratto legale tra Lei (un privato o una società) e la RCF Spa – Reggio 
Emilia - Italia in relazione all’utilizzo di questo software (da qui in poi il “SOFTWARE”).
La preghiamo leggere attentamente i termini del presente Contratto di Licenza prima di 
installare o di utilizzare il SOFTWARE. Con l’installazione, la copia o l’inizio dell’utilizzo del 
SOFTWARE, Lei accetta i termini del presente Contratto di Licenza.

1. CONCESSIONE DELLA LICENZA
RCF Spa Le concede i seguenti diritti non esclusivi per l’uso del SOFTWARE in base ai 
termini del presente Contratto di Licenza.
a. Potrà utilizzare il SOFTWARE su un solo specifico computer per volta. L’uso del 

SOFTWARE include caricare il SOFTWARE nella memoria RAM o installarlo nella 
memoria dell’hard disk del computer sul quale verrà utilizzato il SOFTWARE.

b. Lei potrà eseguire una copia del SOFTWARE solo come backup (CD, DVD o mezzo 
simile), ma è proibito eseguire qualsiasi altra copia.

c. Utilizzo su un singolo PC e in Rete: 
Lei potrà utilizzare il software con qualsiasi apparecchio (PC).
Se però sostituisce il PC, sarà tenuto a cancellare il software dalla sua memoria e 
chiedere al produttore un nuovo codice di licenza (gratuito), in quanto il vecchio codice 
non può più venire utilizzato. L’installazione o l’utilizzo su più di un apparecchio non 
sono consentiti. L’utilizzo del software all’interno di una rete informatica o di altro 
sistema computerizzato con varie postazioni di lavoro non è permesso se il programma 
può essere utilizzato simultaneamente su diversi computer. Se desidera utilizzare il 
software all’interno di una rete o di altro sistema con varie postazioni di lavoro, deve 
acquistare dal produttore vari codici di licenza.

2. COPYRIGHT
Il SOFTWARE ed i relativi copyright sono di proprietà della RCF Spa e sono protetti da tutte 
le leggi ed i trattati internazionali sul copyright. Il SOFTWARE va quindi trattato come ogni 
altro materiale coperto da copyright (un CD, un DVD, un libro). Tutti i diritti non previsti dal 
presente restano riservati alla RCF Spa.
L’informativa di copyright, il numero di serie ed altre caratteristiche identificative del 
software non dovranno essere rimosse o cambiate. Lo stesso vale per la soppressione delle 
caratteristiche appropriate della schermata di programma.

3. ULTERIORI RESTRIZIONI
d. È fatto divieto di modificare, cambiare, ricercare di risalire al codice sorgente, 

decompilare il SOFTWARE nonché l’informativa sul copyright ed il logo protetto da 
copyright.

e. È proibito prestare, noleggiare, affittare o trasferire il SOFTWARE, tutto o in parte, a 
terzi. È possibile però trasferire definitivamente il SOFTWARE ed il materiale stampato 
che lo accompagna ammesso che non se ne conservi nessuna copia e che il ricevente 
accetti i termini di questo Contratto di Licenza. Se il SOFTWARE è stato aggiornato 
ad una versione successiva, qualsiasi trasferimento del SOFTWARE deve comprendere 
l’aggiornamento più recente e tutte le versioni precedenti. Il terzo ricevente dovrà 
ottenere dal produttore un nuovo codice di licenza (gratuito) in modo da garantirsi la 
completa funzionalità del software.

f. Il SOFTWARE non può essere ceduto a terzi se esiste il dubbio che essi possano violare 
i termini contrattuali ed in particolare produrre copie illegali.

g. Se la confezione del presente SOFTWARE contiene vari tipi di supporto (floppy disk 
o CD-ROM) e tali supporti contengono lo stesso software, è ammesso solo l’uso del 
supporto appropriato al computer. È fatto divieto di utilizzare l’altro tipo di supporto 
su un altro computer.

4. NESSUNA GARANZIA
RCF Spa non concede alcuna garanzia, né espressa né implicita, in relazione a nessun 
software, compreso, in senso esemplificativo ma non esaustivo, la commerciabilità o 
l’adeguatezza ad uno scopo particolare.

CONTRATTO 
DI LICENZA

CONTRATTO DI LICENZA 
DEL SOFTWARE RCF FORUM



18

IT
A

LI
A

N
O

5. NESSUNA RESPONSABILITÀ
In nessun caso, la RCF Spa potrà essere ritenuta responsabile nei confronti dell’utente finale 
per danni di qualsiasi genere compresi, in senso esemplificativo ma non esaustivo, danni 
finanziari per mancati utili o per perdita di informazioni commerciali derivanti dall’utilizzo 
o dall’impossibilità di utilizzo del presente prodotto. Tale clausola è efficace anche nel caso 
che la RCF Spa sia stata
avvisata della possibile esistenza di tali danni. Anche nel caso che il SOFTWARE presenti 
errori di programma materiali, verificabili e riproducibili, la RCF Spa non avrà l’obbligo di 
modificare tali errori.

6. CARATTERISTICHE DI SISTEMA
Data la grande varietà di sistemi computerizzati non è possibile determinare le caratteristiche 
di sistema generali per il funzionamento ottimale. Le caratteristiche di sistema raccomandate 
sono state determinate dopo vari test con diversi PC. Anche nel caso che il PC rispecchi le 
caratteristiche di sistema, possono verificarsi problemi con il software RCF FORUM dovuti 
a configurazioni particolari hardware o software. Non è possibile fornire una garanzia 
operativa al 100% con il software RCF
FORUM.

7. RITIRO DELLA LICENZA
La RCF Spa si riserva il diritto di ritirare la Licenza concessa con il presente Contratto nel 
caso di mancato rispetto di uno qualsiasi dei termini del presente Contratto di Licenza. 
All’atto di tale ritiro, si dovrà interrompere immediatamente l’uso del SOFTWARE.

8. GENERALITÀ
Il presente Contratto di Licenza è disciplinato e redatto in conformità alle leggi ITALIANE 
senza riferimento ai principi di conflitti di legge.
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RCF S.p.A. Vi ringrazia per l’acquisto di questo prodotto, realizzato in modo da 
garantirne l’affidabilità e prestazioni elevate.

Inserire il CD contenente il software di installazione nell’apposito lettore. Assicurarsi che 
il computer su cui verrà utilizzato il software abbia i requisiti minimi richiesti (Sistema 
Operativo Windows XP).
Esplorare il contenuto del CD attraverso gli appositi comandi di Windows, e quindi lanciare 
il file “setup....exe” (i puntini indicano un numero progressivo della versione utilizzata).
Apparirà la seguente finestra di dialogo: 

Selezionare la lingua e confermare premendo “OK”. Quindi apparirà la finestra:

Confermare premendo “Avanti”. 

INSTALLAZIONE
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Accettare il contratto di licenza selezionando l’apposita opzione.

A questo punto procedere con l’installazione.

Comparirà la seguente finestra durante la fase di installazione indicante lo stato di 
avanzamento.
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comando “fine”.

A questo punto verrà creata un’icona sul desktop, una cartella in 
DOCUMENTI/ FORUM6000 e nella barra di avvio.

Lanciare il programma Rcf Forum mediante l’icona sul desktop, o i collegamenti nella barra 
Avvio. 
Si aprirà la schermata di gestione principale del programma:

UTILIZZO DEL PROGRAMMA
CONNESSIONE DELL’UNITA 
CENTRALE
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Per connettere il computer all’unità centrale andare nel menu “Opzioni” e selezionare 
“Impostazioni di comunicazione” per impostare la porta di comunicazione utilizzata.

Inserendo il numero della porta “com” da utilizzare e quindi confermare per rendere 
operative le modifiche. 

Ancora dal menu “Opzioni” selezionare “Connetti centrale”. 
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Per poter creare il quadro sinottico della sala, disporre le console, assegnare a queste le 
generalità e inserire un’immagine, aprire la finestra “Sinottico” e deselezionare “Console 
Bloccate”. 
Per inserire uno sfondo nel quadro sinottico, aprire il menù “Sinottico”, “Apri Immagine” 
selezionare e aprire il file desiderato. 
Per spostare le icone delle console all’interno del riquadro selezionare l’icona e tenendo 
premuto il tasto sinistro del mouse trascinarla. Per ruotarla premere il tasto centrale del 
mouse tenendo il cursore sull’icona da ruotare.

Col tasto destro del mouse è possibile attivare e disattivare il microfono della base: si 
accenderà l’anello luminoso posto sull’asta e contemporaneamente l’icona diventerà 
rossa.

CREAZIONE QUADRO 
SINOTTICO
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Per associare nome e cognome alle basi bisogna aprire (doppio click sull’icona della base) 
la finestra di opzioni e

 inserirli negli appositi spazi “Nome” e “Cognome”.

Selezionare la finestra “MODO” per entrare nella schermata di regolazione delle varie 
modalità di conferenza. 

Dal primo riquadro “Free Discussion - Active Mic” è possibile selezionare il numero 
dei microfoni attivi contemporaneamente.
  
ALL DELEGATE OFF. Disabilitazione di tutte le console dei delegati (le console dei 
presidenti sono invece funzionanti).
ALL CONSOLE OFF. Disabilitazione di tutte le console (delegati e presidenti).
FREE DISCUSSION. Discussione libera: nessuna limitazione sul numero delle console 
delegato attivabili.
MAXMICDEL1 + O/RIDE. 1 sola console delegato con il microfono attivato ed eventuale 
“override” (priorità con esclusione) da parte di un’altra console delegato.
DA 1 A 6. Limitazione del numero massimo (n: da 1 a 6) di console delegati che possono 
avere contemporaneamente il microfono attivato.

IMPOSTAZIONE 
MODO CONFERENZA

LE OPZIONI DISPONIBILI 
DEL PRIMO RIQUADRO SONO
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dei microfoni che si possono prenotare per parlare.
Per attivare la funzione di discussione automatica è necessario impostare un numero 
massimo di microfoni attivi (da 1 a 6).

OFF. Disattivazione della funzione di prenotazione dei delegati.
NEXT. Prenotazione consentita ad un solo delegato dopo aver raggiunto il numero 
massimo di delegati attivi. Quando un delegato disattiva il proprio microfono, la console 
prenotata è abilitata automaticamente.
NEXT + NUMERO. Prenotazione consentita a max. 1 + n delegati (dove n vale da 1 a 9) 
dopo aver raggiunto il numero massimo di delegati attivi. Quando un delegato disattiva il 
proprio microfono, la prima console prenotata è abilitata automaticamente.

Dal terzo riquadro “Options” si impostano i parametri della traduzione simultanea, 
degli ingressi ausiliari A e B, dell’uscita jack delle basi microfoniche, il chime e l’auto 
spegnimento del microfono.

OFF. Traduzione disattivata: alle 3 uscite del sistema (linee console, MAIN OUT e 
teleconferenza) è inviato il segnale miscelato delle console, IN A, IN B, IN PLAY (ed il 
campanello “Chime”).
SIMULTANEOUS. Traduzione simultanea attivata: se una delle due console traduttore 
chiede l’abilitazione (e disabilita l’altra), la lingua tradotta è disponibile solo sulle uscite 
jack per cuffie delle console (gli altoparlanti interni delle console sono disattivati). Alle altre 
2 uscite del sistema (MAIN OUT e l’uscita per teleconferenza), è inviato il segnale miscelato 
delle console, IN A, IN B, IN PLAY (ed il campanello “Chime”).
SEQUENTIAL. Traduzione sequenziale attivata: quando una delle due console interprete 
chiede l’abilitazione (disabilitando automaticamente l’altra), la lingua tradotta (l’interprete) 
è inviata alle 3 uscite audio del sistema (linee console, MAIN OUT e l’uscita per 
teleconferenza).

Quando l’interprete disattiva il proprio microfono, sulle 3 uscite audio del sistema è 
nuovamente inviato il segnale miscelato delle console, IN A, IN B, IN PLAY (ed il campanello 
“Chime”).

CMD ACT, VOX ACT. L’ingresso A è attivato se il comando esterno viene chiuso (comando 
= attivazione) o se si rileva automaticamente il segnale (VOX attivo).
CMD ACT, VOX OFF. L’ingresso A è attivato se il comando esterno viene chiuso (comando 
= attivazione); VOX non attivo.
CMD MUTE, VOX ACT. L’ingresso A è attivato se il comando esterno rimane aperto 
(comando = “mute”) e se si rileva automaticamente il segnale (VOX attivo).
CMD MUTE, VOX OFF. L’ingresso A è attivato se il comando esterno rimane aperto 
(“command” = “mute”); VOX non attivo.

Le impostazioni sono identiche a quelle precedenti per l’ingresso MIC / LINE INPUT A 
(parametro: “VOX / CMD INPUT A”), ma riferite all’utilizzo dell’ingresso MIC / LINE INPUT B.

A MIX B MIX SYS. Gli ingressi A, B ed il segnale delle console sono miscelati.
(A LOCK B) MX SYS. Gli ingressi A e B sono interbloccati tra loro (il primo ingresso 
attivato esclude l’altro); il loro segnale è miscelato con quello delle console.
(A PRIO B) MX SYS. L’ingresso A è prioritario su quello B; il loro segnale è miscelato con 
quello dei microfoni delle console. 
(A MX B) PRIO SYS. Gli ingressi A e B sono miscelati ed il loro segnale è prioritario su 
quello delle console.
SYS PRIO (A MX B). Il segnale delle console è prioritario su quello miscelato degli ingressi 
A e B.
A PRIO (B MX SYS). Il segnale dell’ingresso A è prioritario su quello miscelato composto 
dall’ingresso B e le console.

DISABLED. Sulle prese jack di ciascuna console non è presente alcun segnale; l’altoparlante 
non è disattivato.
RECORDING. Sulle prese jack di ciascuna console, è presente il segnale per l’eventuale 
collegamento di un registratore; l’altoparlante non è disattivato.
HEADPHONES. Sulle prese jack di ciascuna console, è presente lo stesso segnale di ritorno 
per l’altoparlante; quando si utilizzano le cuffie, l’altoparlante è disattivato.

LE OPZIONI DISPONIBILI IN 
“INTERPRETATION” SONO

LE OPZIONI DISPONIBILI IN 
“VOX/CMD INPUT A” SONO

LE OPZIONI DISPONIBILI IN 
“VOX/CMD INPUT B” SONO

LE OPZIONI DISPONIBILI IN 
“A/B INPUT MODE” SONO

LE OPZIONI DISPONIBILI IN 
“CONSOLE OUT JACK” SONO

LE OPZIONI DISPONIBILI DEL 
SECONDO RIQUADRO SONO
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Impostazione segnalazione (campanello) di priorità della console presidente.
Pulsante acceso. Il campanello (“chime”) è abilitato sull’intervento con priorità di un 
presidente. 
Pulsante spento. Il campanello è disabilitato (sull’intervento con priorità di un presidente)

Impostazione disattivazione automatica delle console (solo delegati).
Pulsante acceso. Attivazione della funzione che consente di disabilitare automaticamente 
una console delegato dopo 30 secondi in cui non è stato rilevato alcun segnale dalla 
capsula mic.
Pulsante spento. Disabilitazione della funzione che consente di disattivare automaticamente 
una console delegato dopo 30 secondi di silenzio.

Dal quarto riquadro “Antilarsen” si impostano i parametri dell’antilarsen.

BYPASS. Processore “anti-feedback” disattivato
SOFT. intervento leggero del processore “anti-feedback”
HARD. intervento deciso del processore “anti-feedback”

Selezionare la finestra “AUDIO” per entrare nella schermata di regolazione dei volumi:

MASTER: Volume dell’uscita audio principale MAIN OUT.
CONSOLE SPEAKER: Volume degli altoparlanti interni delle console.
CONSOLE MIC: Volume delle console presidenti e delegati.
INTERPRETER MIC: Volume delle console interpreti. 
AUX PLAY: Volume dell’ingresso PLAY.
TELECONFERENCE: Volume dell’ingresso per teleconferenza.
MONITOR: Volume dell’altoparlante della Master Unit.
INPUT A: Volume dell’ingresso MIC / LINE INPUT A (con presa XLR).
INPUT B: Volume dell’ingresso MIC / LINE INPUT B (con presa XLR).

AUDIO SETTINGS

CHIME ON CHAIRMAN

MIC AUTO-OFF

LE OPZIONI DISPONIBILI SONO

LE OPZIONI DISPONIBILI SONO
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Per vedere l’immagine delle telecamere bisogna visualizzare il secondo monitor dall’apposito 
menu (Video/Visualizza):

Per adoperare il SW di gestione delle telecamere bisogna andare in “Plugin / Dome”. 
Apparirà la seguente schermata.

Per poter muovere le telecamere e commutare la matrice video è necessario impostare il 
numero della porta di comunicazione usata dal PC.
Dal punto 1  si seleziona il numero della porta di comunicazione tra il Pc e le telecamere.
Dal punto 2  quella tra il PC e la matrice video.
Una volta impostati questi parametri bisogna abilitare le porte di comunicazione premendo 
i bottoni “Camera”, “Mixer” e “Abilitato”(punto 7 ). L’accensione di questi conferma la 
richiesta di connessione.

GESTIONE TELECAMERE

P

{

}

1 7

8

9

2

3

4

5

6
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Selezionare, dal quadro sinottico della sala, la base microfonica alla quale si intende 
assegnare un puntamento. Selezionare il numero della telecamera con la quale si deve 
andare ad inquadrare la base microfonica (punto 4 ). Selezionare la voce “1 Microfono” 
o “Sala” se l’inquadratura da salvare è relativa a una base microfonica o a un’immagine 
generica di sala (punto 8 ). Muovere la telecamera usando il simulatore di joystick (punto 
5 ). Tenendo premuto il tasto sinistro del mause all’interno del cerchio e spostandosi 

verso l’alto, il basso, sinistra o destra si muoverà la telecamera selezionata. Questa funzione 
permette di muovere velocemente la telecamera. Per una regolazione fine usare le frecce 
poste sulla destra del cerchio. Per regolare lo zoom adoperare i tasti “Wilde” e “Tele” (punto 
{ ). Il fuoco e l’iris della telecamera sono automatici. Se si volesse intervenire manualmente, 
adoperare i tasti “Far” e “Near” per il fuoco e “Open” e “Close” per l’iris (punto { ).
Una volta trovato il corretto puntamento salvarlo premendo il tasto “Save”.
Selezionare il tipo di transizione da adoperare nel passaggio da un’immagine all’altra 
(punto 3 ).
Le transizioni possibili sono 4:
no = nessuna transizione (si vede il movimento della telecamera)
nero = l’inquadratura va a nero, si sposta la telecamera, e riapre da nero l’immagine
sala = si transita da un’immagine di sala
sinottico = si transita dall’immagine del quadro sinottico

Selezionando una base microfonica se si accende il pulsante in basso a sinistra (punto 6 ) 
vuol dire che a quella base microfonica è gia stato salvato un puntamento.
Per cancellare un puntamento bisogna selezionare dal quadro sinottico la base microfonica 
e premere il tasto “Delete” (punto P). Se si vogliono cancellare invece tutti i puntamenti 
bisogna premere il tasto “Clear All” (punto 9). Apparirà una schermata che chiede la 
conferma della scelta. Per entrare nel menu di settaggio delle telecamere bisogna premere il 
tasto “Menu” (punto } ). Sopra l’immagine video apparirà il menu di configurazione della 
telecamera. Usare le frecce poste sulla destra del cerchio per muoversi all’interno del menu. 
Spostandosi verso l’alto o il basso si visualizza la voce del menu che interessa, con la freccia 
a destra si entra nel sottomenu. All’accensione del microfono la telecamera si andrà a 
puntare automaticamente sul preset impostato.
Se vengono accesi due o più microfoni viene visualizzata l’immagine di sala. Quando 
rimarrà acceso solo un microfono la telecamera si ritornerà a puntare la base microfonica 
in funzione. Il passaggio tra un’inquadratura e l’altra avviene sempre con la transizione 
impostata (punto 3 ).

Per effettuare una registrazione audio bisogna prelevare il segnale dall’Unità Centrale DMU 
6100 e darlo in ingresso alla scheda audio del PC.
Dopo aver connesso l’Unità Centrale, aprire dal menù “Finestra” la sezione “Registratore”.
Apparirà la seguente schermata.
Per selezionare il formato di registrazione e la destinazione del file audio aprire dal menù 
“Opzioni” la sezione “Formato Audio” e “Cartella Audio”

Premendo il tasto col simbolo “ ” si avvia la registrazione. La colonna sulla destra del 
riquadro si colorerà di verde appena viene ricevuto il segnale audio.
A questo punto è possibile ridurre a icona la schermata “RcfForumAudio” e procedere con 
la conferenza. Al termine della riunione riaprire la schermata “RcfForumAudio” e premere 
il tasto “ ” per fermare la registrazione.

ASSEGNARE UN PUNTAMENTO 
DELLA TELECAMERA A UNA 
BASE MICROFONICA

GESTIONE 
REGISTRAZIONE AUDIO
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Per visualizzare la lista dei prenotati aprire dal menù “Finestra” la sezione “Lista Prenotati”, 
apparirà la seguente schermata.

 Premendo il primo tasto si attiva il microfono del delegato: il gestore può 
attivare e disattivare qualunque microfono presente nella lista in ogni momento, senza 
dover rispettare l’ordine di prenotazione.
Premendo il secondo tasto si cancella il delegato dalla lista di prenotazione.

Per visualizzare la schermata pubblica aprire dal menù “Finestra” la sezione “Visualizza 
Secondo Monitor”, apparirà la seguente schermata.

Per salvare il quadro sinottico di sala, le impostazioni effettuate nella schermata “MODO” e 
le regolazioni audio, aprire dal menù “File” la sezione “Salva” e procedere con il salvataggio. 
Per richiamare una configurazione salvata, dopo aver acceso il sistema e connesso all’Unità 
centrale, aprire dal menù “File” la sezione “Apri” e caricare il file interessato.

Per attivare o disattivare un microfono dal quadro sinottico, bisogna cliccare col tasto destro 
del mouse sull’icona desiderata. In questo modo si possono accendere anche un numero 
di microfoni superiore a quello settato nel sistema. Se si attiva manualmente un microfono 
che era in “lista prenotati” gli si da la parola senza cancellarlo dalla prenotazione.

GESTIONE 
LISTA PRENOTATI

GESTIONE 
SCHERMATA PUBBLICA
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Reggio Emilia - Italien

Dies ist eine rechtsgültige Vereinbarung zwischen RCF SpA Reggio Emilia - Italien und 
Ihnen (einer natürlichen Person oder einem Unternehmen) hinsichtlich der Nutzung dieser 
Software. Bitte lesen Sie die Bedingungen dieser Lizenzvereinbarung vor der Installation 
oder der Benutzung dieser Software sorgfältig durch.
Die Lizenzvereinbarung tritt in Kraft, wenn die Software installiert, kopiert oder genutzt wird. 
Der Nutzer erklärt sich dann ausdrücklich mit den Bedingungen dieser Lizenzvereinbarung 
einverstanden. 

1. ERTEILUNG EINER LIZENZ
RCF Spa gewährt Ihnen in Übereinstimmung mit den Bestimmungen dieser 
Lizenzvereinbarung das nicht-exklusive Nutzungsrecht dieser Software.  
a. Sie dürfen die Software zeitgleich nur auf einem einzelnen Computer nutzen. Die 

Nutzung der Software beinhaltet das Laden der Software in den Arbeitsspeicher 
(RAM) oder die Installation der Software auf einem Speichermedium (z.B. Festplatte) 
des Computers, auf dem Sie die Software nutzen werden.

b. Es ist Ihnen gestattet, zu Sicherungszwecken eine Kopie der Software zu erstellen (CD, 
DVD oder anderes Medium), weitere Kopien sind jedoch untersagt.

c. Mehrfachnutzung und Netzwerkeinsatz: Sie können die Software an jedem beliebigen 
PC nutzen. Bei einem Wechsel des PCs ist die Software jedoch vom Speichermedium 
des zuvor genutzten Gerätes zu entfernen. Bitte fordern Sie einen neuen (kostenlosen) 
Lizenzschlüssel beim Hersteller an, da der alte Lizenzschlüssel seine Gültigkeit verliert. 
Es ist Ihnen nicht gestattet, die Software auf mehr als einem PC zu speichern oder 
zu nutzen. Die Nutzung der Software in einem Netzwerk oder Computersystem mit 
mehreren Arbeitsplatzrechnern (auf denen das Programm gleichzeitig auf mehreren 
PCs verwendet wird) ist nicht gestattet. Wenn Sie die Software in einem Netzwerk 
(oder einem anderen System mit mehreren Arbeitsplatzrechnern) nutzen möchten, ist 
es notwendig, mehrere Lizenzschlüssel bei RCF SpA zu erwerben.

2. URHEBERRECHT
Die Software und ihre Urheberrechte sind Eigentum der RCF SpA und sind durch alle 
Urheberrechtsgesetze sowie internationale Urheberrechtsabkommen geschützt. Aus 
diesem Grund ist die Software wie alle anderen urheberrechtlich geschützten Waren (d.h. 
CDs, DVDs, Bücher) zu behandeln.
Alle Rechte, die nicht explizit in dieser Bedienungsanleitung erwähnt sind, bleiben RCF SpA 
vorbehalten. 
Die Urheberrechtshinweise, die Seriennummer sowie andere Identifikationshinweise der 
Software dürfen nicht entfernt, verändert oder ausgeblendet werden. 

3. SONSTIGE BESCHRÄNKUNGEN
d. Es ist Ihnen nicht gestattet, die Software, Urheberrechtsinformationen und die Logos 

zu verändern, auszutauschen, oder zu versuchen diese zu dekompilieren.
e. Es ist nicht gestattet, die Software zu verleihen, zu vermieten, ganz oder teilweise 

auf andere zu übertragen oder Unterlizenzen zu vergeben. Es ist gestattet, die 
Software (sowie die entsprechenden gedruckten Unterlagen) permanent auf andere 
zu übertragen, wenn Sie keine Kopien der Software zurückbehalten und der neue 
Eigentümer den Bedingungen dieser Lizenzvereinbarung zustimmt. Wurde die 
Software aktualisiert, sollte die Weitergabe der Software das neueste Update, sowie 
alle früheren Versionen beinhalteten. Um den vollen Funktionsumfang der Software 
zu gewährleisten, sollte der neue Besitzer einen neuen (kostenfreien) Lizenzschlüssel 
beim Hersteller anfordern. 

f. Sie dürfen die Software nicht Dritten zugänglich machen, wenn Sie damit die 
Vertragsbedingungen in Bezug auf die Erstellung illegaler Kopien verletzen.

g. Falls die Software auf mehreren Datenträgern (wie Disketten und CD-ROMs) in gleicher 
Form enthalten ist, dürfen Sie ausschließlich den für Ihren Computer geeigneten 
Datenträger nutzen. Sie sind nicht berechtigt, die verbleibenden Datenträger auf 
anderen Computern zu nutzen.

LIZENZVEREINBARUNG

LIZENZVEREINBARUNG 
FÜR RCF FORUM-SOFTWARE 
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4. GARANTIEAUSSCHLUSS
RCF SpA übernimmt in Bezug auf jegliche Software keinerlei Garantie, weder ausdrücklich 
noch stillschweigend, einschließlich, aber nicht beschränkt auf die Marktfähigkeit oder 
Eignung für einen bestimmten Zweck.

5. HAFTUNGSAUSSCHLUSS
In keinem Fall haftet RCF SpA gegenüber dem Endverbraucher für Schäden jeglicher Art, 
einschließlich, aber nicht beschränkt auf finanzielle Schäden durch Gewinnausfälle oder 
den Verlust von Geschäftsdaten infolge der Nutzung der Software oder der Unmöglichkeit 
der Nutzung dieses Produkts.   
Die vorangehende Bestimmung ist auch wirksam, wenn RCF SpA auf die Möglichkeit 
solcher Schäden hingewiesen wurde. Selbst im Falle von materiellen, nachprüfbaren und 
reproduzierbaren Programmfehlern der Software besteht für RCF SpA keine Verpflichtung, 
derartige Fehler zu beheben.

6. PC-SYSTEMANFORDERUNGEN
Angesichts der großen Vielfalt an Computersystemen ist es nicht möglich, generelle 
Systemanforderungen für den optimalen Betrieb anzugeben. Die empfohlenen 
Systemanforderungen, die sie in dieser Bedienungsanleitung finden, wurden mithilfe 
mehrerer Tests mit unterschiedlichen PC-Systemen bestimmt. Selbst wenn Ihr PC-System 
diese Anforderungen erfüllt, können aufgrund spezieller Hard- oder Softwarekonfigurationen 
Probleme mit der RCF Forum-Software auftreten. (Es kann somit keine hundertprozentige 
Kompatibilität der RCF Forum-Software garantiert werden).

7. KÜNDIGUNG DER LIZENZ
RCF behält sich das Recht vor, dem Nutzer die Lizenz im Falle der Nichteinhaltung der 
Bedingungen der Lizenzvereinbarung zu entziehen. Zum Zeitpunkt dieses Widerrufs ist die 
Nutzung der Software unverzüglich einzustellen.

8. ALLGEMEINES
h. Sollten einzelne Bestimmungen dieser Vereinbarung gemäß einer gültigen 

Rechtsordnung unwirksam oder undurchführbar sein, bleibt davon die Wirksamkeit 
des Vertrages im Übrigen unberührt. 

i. Diese Lizenzvereinbarung unterliegt italienischem Recht (ohne Bezugnahme auf die 
Prinzipien des Kollisionsrechts). 
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RCF S.p.A. dankt Ihnen für den Kauf dieses Produkts, das für höchste 
Zuverlässigkeit und Leistungsfähigkeit ausgelegt ist. 

Legen Sie die CD mit der Installationssoftware in das entsprechende Laufwerk ein. 
Stellen Sie sicher, dass der Computer, auf dem die Software installiert werden soll, die 
Mindestsystemanforderungen (Windows XP - Betriebssystem) erfüllt. Durchsuchen Sie 
die Inhalte der CD mit den normalen Windows-Befehlen, führen Sie dann die »setup ... 
. exe«-Datei aus. (Die drei Punkte stehen für eine fortlaufende Nummer der verwendeten 
Version).
Das folgende Dialogfenster wird geöffnet:

Wählen Sie Ihre Sprache aus und bestätigen Sie diese mit »OK«. Das folgende Fenster 
erscheint:

Bestätigen Sie mit »Weiter«.

INSTALLATION
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Stimmen Sie den Lizenzbestimmungen zu, um fortzufahren.

Fahren Sie mit der Installation fort, indem Sie das Verzeichnis wählen, in das die Software 
installiert werden soll.

Während der Installation erscheint das folgende Fenster, das den Installationsfortschritt 
anzeigt. 
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Sobald die Installation abgeschlossen ist, klicken Sie auf »Beenden«.

Ein Programm-Icon wird auf dem Desktop erstellt. Zudem wird ein 
neuer Ordner in »../Eigene Dateien/Forum6000« sowie ein Eintrag im 
Startmenü erzeugt.

Führen Sie das Programm aus, indem Sie entweder auf das Programmsymbol auf dem 
Desktop, auf den Link in der Startleiste oder im »RCF Forum«-Ordner klicken. 
Es öffnet sich das Haupt-Verwaltungsfenster des Programms:

NUTZUNG DES PROGRAMMS
ANSCHLUSS DER STEUERUNGSEINHEIT
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Um den Computer mit der Steuerungseinheit zu verbinden, öffnen Sie das Menü »Optionen« 
(Options) und wählen Sie »Com Port Setup« aus, um den richtigen Kommunikations-Port 
einzustellen. 

Wählen Sie unter »Com« die Port-Nummer aus und bestätigen Sie diese mit »OK«.

Wählen Sie dann »Verbinde Zentrale« (Connect central unit) im Menü »Optionen« (Options) aus. 
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Um ein Übersichtspanel des Konferenzraums einzurichten, die Konsolen anzuordnen, 
allgemeine Informationen einzugeben und ein Bild einzufügen, öffnen Sie das Menü 
»Synoptic« und deaktivieren Sie den Unterpunkt »Blocked Consoles«. Um ein Hintergrundbild 
im Rahmen des Übersichtspanels einzufügen, wählen Sie die Option »lade Bild« (load 
Picture) im Menü »Synoptic«. Wählen und öffnen Sie die gewünschte Bilddatei.

Um die Symbole der Konsolen innerhalb des Rahmens zu verschieben, wählen Sie das 
entsprechende Symbol und ziehen Sie dieses bei gedrückter linker Maustaste an die 
gewünschte Position. Um ein Symbol zu drehen, halten Sie den Mauszeiger über das zu 
drehende Symbol und drücken Sie die mittlere Maustaste.

Verwenden Sie die rechte Maustaste, um das Konsolenmikrofon zu aktivieren und zu 
deaktivieren: der Ring am Mikrofon leuchtet auf, gleichzeitig wird das entsprechende 
Symbol im Übersichtspanel rot.

ERSTELLEN EINES 
ÜBERSICHTSPANELS 
DES KONFERENZRAUMS
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Sie können der Konsole einen Namen zuweisen indem Sie in den Feldern »Name« und 
»Nachname« (Surname) eine Eingabe vornehmen. 
Doppelklicken Sie auf ein Konsolensymbol, um das entsprechende Detailfenster zu öffnen:

Wählen Sie den Reiter »Mode« (Conference), um das entsprechende Einstellungsfenster 
zur Anpassung aller Parameter zu öffnen: 

In der ersten Box »Free Discussion - Active Mic« können Sie die maximale Zahl an 
Teilnehmern bzw. gleichzeitig aktiver Konsolenmikrofone einstellen.
   
ALL CONS OFF: alle Konsolen (außer die der Dolmetscher) sind deaktiviert. 
ALL DEL OFF: alle Teilnehmer-Konsolen sind deaktiviert (die Konsole des Konferenzleiters 
ist aktiviert). 
FREE DISCUSSION: keine Begrenzung der Anzahl aktiver Teilnehmer-Konsolen (freie 
Diskussion). 
MAXMICDEL1 + O/RIDE: Zu jedem Zeitpunkt ist genau eine Teilnehmerkonsole aktiv, 
diese wird vom nächsten Teilnehmer deaktiviert (override).
1 BIS 6: Die max. Anzahl aktiver Teilnehmermikrofone ist auf die Nummern 1 bis 6 begrenzt.

In der zweiten Box »Automatic - Reservation« kann eine Teilnehmerreservierung 
vorgenommen werden.
Um die Funktion »automatische Diskussionsführung« zu aktivieren, muss die maximale 
Anzahl von aktiven Mikrofonen (1-6) eingestellt werden.

EINSTELLUNGEN 
DES KONFERENZMODUS

OPTIONEN IM MENÜ 
»ACTIVE MIC«

OPTIONEN IM MENÜ 
»RESERVATION«
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OFF: die Reservierungsfunktion ist deaktiviert. 
NEXT: Nachdem die max. Anzahl aktiver Mikrofonkonsolen erreicht ist, kann nur ein einziger 
Teilnehmer seinen Beitrag vormerken. Sobald ein Teilnehmer sein Mikrofon ausschaltet, 
schaltet sich das Mikrofon des reservierten Teilnehmers automatisch ein. 
NEXT + N: Nachdem die max. Anzahl aktiver Mikrofonkonsolen erreicht ist, können 1 + n (n = 
1 bis 9) Teilnehmer ihren Beitrag vormerken. Sobald ein Teilnehmer sein Mikrofon ausschaltet, 
wird das Mikrofon des nächsten Teilnehmers in der Warteschlange automatisch aktiviert.

In der dritten Box »Options« können Sie Parameter der Simultanübersetzung, die 
Modi der Eingänge A und B, VOX/CMD Eingang A, VOX/CMD Eingang B, Gong auf 
Konferenzleiter (Chime On Chairman), Konsole Ausgangs-Stecker sowie die automatische 
Mikrofonabschaltung (Mic Auto Off) auswählen. 

OFF: Die Dolmetscherkonsolen sind deaktiviert.
SIMULTANEOUS (Simultanübersetzung): Wird eine Dolmetscherkonsole aktiviert (Hinweis: 
die anderen Dolmetscherkonsolen werden automatisch deaktiviert), wird die übersetzte 
Sprache an die Klinkenausgänge der Konsole geroutet (die internen Lautsprecher der 
Konsole sind deaktiviert). Das gemischte Signal aller Konsolen, der Eingänge IN A, IN B, IN 
PLAY (und des Gong) wird an die beiden anderen System-Audioausgänge (MAIN OUT und 
Audio-Ausgang für Telekonferenzen) geroutet. 
SEQUENTIAL (sequentielle Übersetzung): Wird eine Dolmetscherkonsole aktiviert (Hinweis: 
die anderen Dolmetscherkonsolen werden automatisch deaktiviert), wird die übersetzte 
Sprache an alle drei System-Audioausgänge (Konsolenreihenschaltung, MAIN OUT, Audio-
Ausgang für Telekonferenzen) geroutet. Wird die Dolmetscherkonsole deaktiviert, wird das 
gemischte Signal aller Konsolen, der Eingänge IN A, IN B, IN PLAY (und des Gong) an die 
drei System-Audio-Ausgänge geroutet. 

CMD ACT, VOX ACT: Eingang A kann entweder per externem Befehl (Befehl = Aktivierung) 
oder automatischer Signalerkennung (VOX-Funktion) aktiviert werden. 
CMD ACT, VOX OFF: Eingang A kann nur per externem Befehl (Befehl = Aktivierung) 
aktiviert werden. Die VOX-Funktion ist deaktiviert.
CMD MUTE, VOX ACT: Eingang A ist aktiviert, wenn kein externer Befehl aktiv ist (Befehl 
= Stummschaltung) und das Signal wird automatisch erkannt (VOX). 
CMD MUTE, VOX OFF: Eingang A ist aktiviert, wenn kein externer Befehl aktiv ist (Befehl 
= Stummschaltung). Die VOX-Funktion ist deaktiviert.

Diese Einstellungen entsprechen denen des Eingangs A (“VOX / CMD INPUT A”), beziehen 
sich jedoch auf Eingang B.

A MIX B MIX SYS: Eingang A, Eingang B und das Signal der Konsole werden gemischt.
(A LOCK B) MIX SYS: Eingang A und B miteinander verschaltet (Der erste aktive Eingang 
deaktiviert den anderen). Eingang A bzw. B und das Signal der Konsole werden gemischt. 
(A PRIO B) MIX SYS: Eingang A hat eine höhere Priorität als Eingang B. Eingang A bzw. 
B und das Signal der Konsole werden gemischt.  
(A MIX B) PRIO SYS: Eingang A und B werden gemischt. Die Eingangssignale A und B 
haben eine höhere Priorität als das Signal der Konsole. 
SYS PRIO (A MIX B): Eingang A und B werden gemischt. Das Signal der Konsole hat eine 
höhere Priorität als die Eingangssignale A und B.
A PRIO (B MIX SYS): Eingang B und die Konsolensignale werden gemischt. Eingang A hat 
eine höhere Priorität als Eingang B und das Signal der Konsole.

DISABLED (Deaktiviert): Kein Signal liegt am Klinkenausgang der Konsole an (die internen 
Lautsprecher sind aktiviert). 
RECORDING (Aufnahme): Am Klinkenausgang der Konsole liegt ein für die Aufnahme 
optimiertes Signal an. Der interne Lautsprecher der Konsole bleibt aktiviert.  
HEADPHONE (Kopfhörer): Das Signal der internen Lautsprecher wird an den Klinkenausgang 
der Konsole (für den Betrieb eines Kopfhörers) geroutet. Ist ein Kopfhörer angeschlossen, 
wird der interne Lautsprecher deaktiviert.  

AKTIVIERT: Das Gongsignal (Chime) wird gesendet, wenn der Konferenzleiter (mit 
Priorität) interveniert. 
DEAKTIVIERT: Das Gongsignal ist deaktiviert (bei Interventionen des Konferenzleiters). 

OPTIONEN IM MENÜ 
»INTERPRETATION« 
(ÜBERSETZUNG)

OPTIONEN IM MENÜ 
»VOX / CMD INPUT A«

OPTIONEN IM MENÜ 
» VOX / CMD INPUT B«

OPTIONEN IM MENÜ 
»A/B INPUT MODE«

OPTIONEN IM MENÜ 
»CONSOLE OUT JACK«

OPTION »CHIME ON 
CHAIRMAN« (GONGSIGNAL 
AUF KONFERENZLEITER)
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AKTIVIERT: nach 30 Sekunden Stille (kein Signal an der Mikrofonkapsel) wird das Mikrofon 
automatisch deaktiviert. 
DEAKTIVIERT: Die »Mic Auto Off«-Funktion ist deaktiviert.

In der vierten box »antilarsen« können sie die anti-feedback-optionen einstellen:

BYPASS: Der Anti-Feedback-Prozessor ist deaktiviert. 
SOFT: Die Sensitivität des Anti-Feedback-Prozessors ist moderat. 
HARD: Die Sensitivität des Anti-Feedback-Prozessors ist hoch.

Wählen Sie den Reiter »Audio«, um die Lautstärke-Einstellungen zu verwalten:

MASTER: Lautstärke des Master-Ausgangs (MAIN OUT). 
CONSOLE SPEAKER (KONSOLENLAUTSPRECHER): Lautstärke der internen Lautsprecher.
CONSOLE MIC (KONSOLENMIKROFON): Lautstärke der Teilnehmer-/ Konferenzleiterkonsole.
INTERPRETER MIC (DOLMETSCHERMIKROFON): Lautstärke der Dolmetscherkonsole.  
AUX PLAY: Lautstärke des PLAY-Eingangs.
TELECONFERENCE: Lautstärke des TELECONF.-Eingangs.
MONITOR: Lautstärke der Master-Einheit (interner Abhörlautsprecher).
INPUT A: Lautstärke von Eingang A (MIC/LINE INPUT A).
INPUT B: Lautstärke von Eingang B (MIC/LINE INPUT B).

AUDIO-EINSTELLUNGEN

OPTION »MIC AUTO OFF 
30 SEC«
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Um das Bild der Videokameras zu sehen, wählen Sie den zweiten Monitor mit der Option 
»Show« im entsprechenden Menü »Video«:

Um die Verwaltung der Videokameras SW zu verwenden, wählen Sie unter dem Menüpunkt 
»Plugin« die Option »Dome«. 
Das folgende Fenster (»Dome«) öffnet sich.

Um die Videokameras bewegen und die Videomatrix umschalten zu können, müssen Sie die 
Nummer des Kommunikationsports angeben, der vom PC verwendet wird.
Unter Punkt 1  wählen Sie den Kommunikationsport zwischen PC und Videokameras.
Unter Punkt 2  wählen Sie den Kommunikationsport zwischen PC und Videomatrix.
Nachdem die Parameter eingestellt wurden, müssen die Kommunikationsports per Klick auf 
die Schaltflächen »Camera«, »Mixer« und »Enabled« (Punkt 7 ) aktiviert werden. Diese 
leuchten auf, um die angeforderte Verbindung zu bestätigen.

VERWALTUNG 
DER VIDEOKAMERAS
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Wählen Sie im Übersichtspanel die Mikrofonkonsole aus, auf welche die Videokamera 
ausgerichtet werden soll. Wählen Sie die Nummer der Videokamera, die auf die 
Mikrofonkonsole ausgerichtet werden soll (Punkt 4 ). Wählen Sie dann unter Punkt 
8 ) entweder »1 Microphone« oder »Hall«, abhängig davon, ob unter der gewählten 

Einstellung eine Mikrofonkonsole oder der Konferenzraum abgespeichert werden soll.
Verwenden Sie den Joystick-Simulator (Punkt 5 ). um die Kamera zu bewegen. Halten Sie dafür 
die linke Maustaste innerhalb des Kreises gedrückt und bewegen Sie den Zeiger nach oben, 
unten, links oder rechts, um die Kamera in die entsprechende Richtung zu schwenken. Diese 
Funktion ermöglicht eine schnelle Bewegung der Kamera. Nutzen Sie für die Feineinstellung der 
Kameraposition die Pfeiltasten rechts neben dem Kreis. Verwenden Sie die Schaltflächen »Wide« 
und »Tele« (Punkt 11 ), um den Zoom der Kamera einzustellen. Die Einstellungen des Fokus 
(Schärfe) und der Blende werden von der Kamera automatisch vorgenommen. Um manuelle 
Einstellungen vorzunehmen, verwenden Sie für den Fokus die Schaltflächen »Far« und »Near«, 
für die Blende die Schaltflächen »Open« und »Close« (Punkt 11 ). Wenn Sie die Einstellungen 
des Bildausschnitts vorgenommen haben, speichern Sie diese mit »Save«. Wählen Sie den Typ des 
Übergangs (Überblendung) von einer Kameraeinstellung zur nächsten (»Transition«, Punkt 3 ).
Es stehen vier Übergangsoptionen zur Verfügung: 
No = kein Übergang (Sie sehen die Bewegung der Kamera).
Black = Schwarzblende: Das Bild wird schwarz, die Kamera bewegt sich, das Bild wird 
wieder eingeblendet. 
Hall = Übergang ausgehend von einer totalen Einstellung des Konferenzraums.
Synoptic = Übergang ausgehend von einem Bild des Übersichtspanels.

Leuchtet bei der Auswahl einer Mikrofonkonsole die Schaltfläche (Punkt 6 ) in der unteren linken 
Ecke auf, dann wurde für diese Mikrofonkonsole bereits eine Kameraeinstellung abgespeichert. Um 
eine Kameraeinstellung zu löschen, wählen Sie die entsprechende Konsole aus dem Übersichtspanel 
und betätigen Sie die Schaltfläche »Delete« (Löschen, Punkt 10 ). Um alle Kameraeinstellungen zu 
löschen, betätigen Sie »Clear all« (Punkt 9  ). Zur Bestätigung des Vorgangs öffnet sich ein Fenster. 
Um das Konfigurationsmenü der Videokamera zu öffnen, betätigen Sie die Schaltfläche »Menu« 
(Punkt 12 ). Das Konfigurationsmenü der Videokamera öffnet sich vor dem Videobildschirm. 
Verwenden Sie die Pfeiltasten rechts vom Kreis, um innerhalb des Menüs zu navigieren. Gehen 
Sie nach oben oder nach unten um den gewünschten Menüpunkt auszuwählen und verwenden 
Sie die rechte Pfeiltaste, um in das Untermenü zu gelangen. Wird eine Mikrofonkonsole aktiviert, 
richtet sich die Videokamera automatisch gemäß der gewählten Einstellungen aus. Werden zwei 
oder mehr Mikrofone aktiviert, wird das Bild des Konferenzraums angezeigt. Wird nur ein Mikrofon 
aktiviert, richtet sich die Kamera erneut auf diese Mikrofonkonsole aus. Der Übergang zwischen 
dem einen und dem nächsten Kamerabild geschieht stets mit der unter Punkt 3  gewählten 
Übergangsoption.

Bei der Aufnahme sollte das Audiosignal des Ausgangs der DMU 6100 Haupteinheit 
verwendet und mit dem Eingang der Soundkarte des PC verbunden werden. 
Nach Anschluss der Haupteinheit öffnen Sie die Option »Recorder« unter dem Menüpunkt 
»Window«:
Wählen Sie »Audio Path« (im Menü »Optionen«), um den voreingestellten Speicherort 
(-pfad) anzuzeigen bzw. zu ändern, an dem die Audioaufnahmen abgelegt werden. Wählen 
Sie »Audio Format« (im Menü »Optionen«), um die Audiokompression für die Aufnahmen 
auszuwählen. 
Um die Aufnahme zu starten, klicken Sie auf die Schaltfläche “ ” Die Pegelanzeige auf 
der rechten Seite leuchtet auf und zeigt den jeweiligen Eingangspegel an. Das RcfForumAudio-
Fenster kann nun minimiert und die Konferenz begonnen werden.
Öffnen Sie nach dem Ende der Konferenz erneut das RcfForumAudio-Fenster und betätigen 
Sie die Schaltfläche “ ” um die Aufnahme zu stoppen. 

AUSRICHTEN DER 
VIDEOKAMERA AUF 
EINE MIKROFONKONSOLE

VERWALTUNG DER 
AUDIOAUFNAHMEN



42

D
EU

TS
CH

Klicken Sie auf die Option »On Hold« im Menü »Window«, um die Reservierungsliste (Rednerliste) 
anzuzeigen. Das nachfolgende Fenster wird geöffnet. Die Reservierungsliste zeigt die Namen 
der Konferenzteilnehmer, die einen Redebeitrag reserviert haben. Im Moment der Reservierung 
ändert die Schaltfläche ihre Farbe (von grau nach blau), um die Reservierung zu bestätigen.  

 Die erste Schaltfläche aktiviert das Mikrofon der Teilnehmer: Der Konferenzleiter 
kann jedes Teilnehmermikrofon auf der Liste jederzeit aktivieren und deaktivieren, 
unabhängig von der Reservierungsreihenfolge. Die zweite Schaltfläche löscht den 
Teilnehmer aus der Reservierungsliste.

Klicken Sie auf die Option »zeige öffentliche Anzeige« (Show public view) im Menü 
»Window«, um die öffentliche Ansicht anzuzeigen.

Klicken Sie auf »speichern« (Save) im Menü »File«, um das Übersichtspanel sowie die Audio- 
und Videoeinstellungen abzuspeichern. Um eine gespeicherte Konfiguration aufzurufen, klicken 
Sie, nachdem Sie den PC an die Haupteinheit angeschlossen und das System eingeschaltet 
haben, auf »öffnen« (Open) im Menü »File« und wählen Sie die entsprechende Datei aus. 

Klicken Sie im Übersichtspanel mit der rechten Maustaste auf das entsprechende Symbol, 
um die zugehörige Mikrofonkonsole zu aktivieren bzw. zu deaktivieren. Auf diese Weise 
ist es möglich, mehr Mikrofone zu aktivieren, als bereits im System eingestellt wurden. 
Wird ein Mikrofon manuell aktiviert, das in der Reservierungsliste enthalten ist, wird dieses 
aktiviert ohne dieses aus der Reservierungsliste zu löschen.   

RESERVIERUNGSLISTE

ÖFFENTLICHE ANSICHT 
(PUBLIC VIEW)
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tel. +39 0522 274 411
e-mail: info@rcf.it

RCF UK
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e-mail: info@rcfaudio.co.uk
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